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Welcome to Using Application 
Performance Lifecycle

This guide describes how to work with the Application Performance 
Lifecycle application.

How This Guide Is Organized

The guide contains the following chapters:

Chapter 1 Introduction to Application Performance Lifecycle

Introduces the Application Performance Lifecycle application and describes 
the Application Performance Lifecycle workflow.

Chapter 2 Working with Application Performance Lifecycle Reports

Describes how to work with Application Performance Lifecycle’s Business 
Process Distribution, Typical Transaction Load, and Location Load Analysis 
reports in order to generate VuGen script templates and pinpoint other data 
that can be incorporated in your Mercury Performance Center load test.

Chapter 3 Refining Your Script Template in VuGen

Describes how to customize the scripts you generated using Application 
Performance Lifecycle so that you can use them in a Performance Center 
load test.
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Chapter 4 Configuring and Running a Load Test

Describes how to configure and run a Performance Center load test or a 
LoadRunner scenario that incorporates the Application Performance 
Lifecycle-generated VuGen scripts as well as other data from the Application 
Performance Lifecycle reports. 

Chapter 5 Working with the Central Repository Service (CRS)

Describes how to export Application Performance Lifecycle reports to the 
Central Repository Service (CRS), generate a script template and save it in 
the CRS, open scripts saved in the CRS, retrieve reports saved in the CRS, 
and upload scripts saved in the CRS to Performance Center.

Who Should Read This Guide

This guide is intended for quality assurance engineers who want to 
construct Performance Center load tests based on Real User Monitor 
transaction data, so that these load tests can more accurately simulate load.

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with Mercury Business Availability 
Center and enterprise monitoring and management concepts. However, this 
guide assumes that Real User Monitor application, page, and transaction 
configuration for Application Performance Lifecycle will be performed in 
conjunction with the person in your organization who is responsible for 
Real User Monitor administration.

In addition, it is assumed that readers of this guide are quite knowledgeable 
in working with VuGen and highly skilled in constructing and running load 
tests using Performance Center.
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Getting More Information

For information on using and updating the Mercury Business Availability 
Center Documentation Library, reference information on additional 
documentation resources, typographical conventions used in the 
Documentation Library, and quick reference information on deploying, 
administering, and using Mercury Business Availability Center, refer to Getting 
Started with Mercury Business Availability Center.



Welcome

viii



1

1
Introduction to Application Performance 
Lifecycle

Application Performance Lifecycle is designed to integrate between Mercury 
Business Availability Center and Mercury Performance Center, enabling you 
to construct load tests based on real-user transaction data collected by the 
Real User Monitor.

Overview of Application Performance Lifecycle

Application Performance Lifecycle enables quality assurance engineers to 
design load tests based on data leveraged from a production environment, 
rather than a testing environment. Using Application Performance 
Lifecycle, the QA engineer can construct load tests that are based on real-
user transaction data and are therefore a more accurate simulation of load 
than standard Performance Center load tests. Application Performance 
Lifecycle thus increases the effectiveness of load tests and provides the QA 
team with more accurate test results.

This chapter describes: On page:

Overview of Application Performance Lifecycle 1

Working with Application Performance Lifecycle 2
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To achieve this goal, Application Performance Lifecycle provides the 
following:

➤ Production Analysis reports from which the QA engineer can extract real-
user transaction data to be used in Performance Center load tests

➤ the ability to create Virtual User Generator (VuGen) script templates, based 
on real-user activity

Working with Application Performance Lifecycle

Working with Application Performance Lifecycle involves performing the 
following procedures:

 1 Ensure that Real User Monitor transactions are defined and that a 
transaction snapshot collection schedule is configured.

For details on configuring Real User Monitor transactions and a transaction 
snapshot collection schedule, see “Configuring the Real User Monitor” in 
End User Management Data Collector Configuration.

 2 In Application Performance Lifecycle’s Production Analysis reports, 
analyze production performance data, export the data you want to use 
when building a Performance Center load test, select the real-user 
transactions and sessions you want to use in your VuGen scripts, and 
generate script templates.

For details on extracting the data you require from the Production Analysis 
reports, see Chapter 2, “Working with Application Performance Lifecycle 
Reports.”

 3 In VuGen, refine the script templates.

For details on the customization required to adjust the scripts generated by 
Application Performance Lifecycle for use in a Performance Center load test, 
see Chapter 3, “Refining Your Script Template in VuGen.”
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 4 In Performance Center or LoadRunner, set up and run a load test or 
scenario that incorporates the scripts you created and refined and 
emulates the real-user behavior displayed in the Production Analysis 
reports.

For details on how to configure and run a load test in Performance Center or 
a scenario in LoadRunner that incorporates production data, see Chapter 4, 
“Configuring and Running a Load Test.”
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2
Working with Application Performance 
Lifecycle Reports

You use Application Performance Lifecycle’s Production Analysis reports to 
pinpoint data that you want to use in building your Performance Center 
load test.

This chapter describes: On page:

Business Process Distribution Report 6

Typical Transaction Load Report 15

Location Load Analysis Report 21

Using Application Performance Lifecycle Reports – A Case Scenario 25
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Business Process Distribution Report

The Business Process Distribution report shows transaction run and 
transaction response time data over time for the configured transactions 
monitored by the Real User Monitor. You can drill down in this report to 
view data for each session in which the displayed transactions were run.

In addition, you use the Business Process Distribution report to create 
VuGen script templates that can be used in a Performance Center load test. 
You can create a VuGen script template in one of two ways:

➤ by instructing Application Performance Lifecycle to automatically generate 
a script template based on a session it selects

➤ by manually selecting the specific session you want to include in your script 
template

This section includes the following topics:

➤ “Generating the Business Process Distribution Report” on page 6

➤ “Analyzing the Business Process Distribution Report” on page 10

➤ “Replaying a Session” on page 14

➤ “Generating a Script Template” on page 15

Generating the Business Process Distribution Report
You select the time range and granularity for the Business Process 
Distribution report as you would for any other Mercury Business Availability 
Center report. For details, see “Working in Reports” in Working with 
Applications. Note that if you already selected a time range in one of the 
other Production Analysis reports, the time range you previously selected 
will automatically be displayed in the Business Process Distribution report.

You then select one of two filter options – Show X transactions or 
Transaction Selection:

➤ Show X transactions – Choose the number of real-user transactions you 
want the report to display and the criteria according to which you want 
Application Performance Lifecycle to select the transactions it displays.
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You can choose to display the transactions:

◆ with the greatest number of runs – If you select this option, Application 
Performance Lifecycle displays the real-user transactions that 
experienced the highest total number of run instances.

◆ with the worst response times – If you select this option, Application 
Performance Lifecycle displays the real-user transactions that 
experienced the greatest overall transaction time.

◆ with the highest session popularity – If you select this option, 
Application Performance Lifecycle displays the real-user transactions that 
were most popular among the sessions. Popularity is determined by 
dividing the number of unique sessions running a transaction by the 
total number of sessions.

◆ with the lowest availability – If you select this option, Application 
Performance Lifecycle displays the real-user transactions that 
experienced the lowest transaction availability. 

You can choose to display the transactions from all monitored applications 
that meet the selected criteria, or you can choose to display only 
transactions that were defined for a specific application.

➤ Transaction Selection – In the Select Transactions dialog box, choose All 
applications to display the transactions from all monitored applications, or 
choose a specific application to display only transactions that were defined 
for that application. Select the transaction(s) for which you want to view 
data, and click the first arrow. To view data for all the transactions listed, 
click the second arrow. Click OK to close the dialog box and save your 
settings.

Note: If you already selected transactions in one of the other Production 
Analysis reports, these transactions will automatically be selected in the 
Business Process Distribution report.
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When you click the Generate button, the Business Process Distribution 
report displays the following:

➤ a summary table listing each transaction, the application with which the 
transaction is associated, the total number of run instances for the 
transaction, the average total transaction time, the percentage of unique 
sessions in which the transaction was run, and the transaction’s availability. 
(Note that the color-coding of the Availability column is based on the 
transaction’s availability in relation to the transaction availability threshold 
you defined in Monitor Administration.)

➤ the percentage of sessions in which the displayed transactions were run, 
which provides you with an indication of the number of sessions covered by 
the Real User Monitor transactions you configured

➤ the Transaction Runs Over Time graph

➤ the Transaction Response Time Over Time graph
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Note: You can print the report, produce a printer-friendly version of the 
report in .pdf format, format the report in .csv or .xml format, send the 
report by e-mail, publish the report with updated data, or save the report to 
the report repository using the toolbar at the top right-hand corner of the 
report. For details, see “Sharing and Storing Reports” in Working with 
Applications.

If the Central Repository Service (CRS) is enabled, you can export a PDF of 
the report to the CRS by selecting Export > Central Repository Service. For 
details on exporting the report to the CRS, see “Exporting a Report to the 
CRS” on page 42.

Analyzing the Business Process Distribution Report
You use the Business Process Distribution report to pinpoint the Real User 
Monitor transactions with the greatest number of runs and the highest 
session popularity. You then drill down in this report to view the individual 
sessions in which these transactions were run. You can also use the Business 
Process Distribution report to pinpoint the transactions that were 
problematic in terms of response time and availability and drill down so 
that you can isolate the sessions, and pages within the sessions, that were 
problematic.

You select a session—either one that was popular and contained a large 
number of transaction runs, or one that was problematic in terms of 
response time or availability—as the basis for your VuGen script template. 
Alternatively, you can select transactions from the Business Process 
Distribution report and instruct Application Performance Lifecycle to 
automatically select a session for each transaction and generate a VuGen 
script template based on this session.
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Note: You can use this report in conjunction with the Typical Transaction 
Load report to ensure that the transactions you select reflect typical 
transaction behavior during the selected time period. For details on using 
the Business Process Distribution report in conjunction with the Typical 
Transaction Load report, see “Using Application Performance Lifecycle 
Reports – A Case Scenario” on page 25.

To analyze the Business Process Distribution report:

 1 Select a transaction, based on the total number of runs for the transaction as 
well as the transaction’s session popularity (or response time/availability 
data), and click the View Sessions button.

Note: You can also select one or more transactions and click Generate 
Scenario Package to instruct Application Performance Lifecycle to 
automatically select a session for each transaction and generate a VuGen 
script template based on this session. For each transaction, Application 
Performance Lifecycle selects the session with a combination of the greatest 
number of runs, the shortest duration, and the least number of errors. 
Application Performance Lifecycle then generates a VuGen script template 
based on each session, as well as a Summary report containing the Business 
Process Distribution report, the Typical Transaction Load report, and the 
Location Load Analysis report for the selected transactions.

If you have enabled the CRS on the Infrastructure Settings Manager page, 
you are prompted to save the scenario package in the repository. For details 
on enabling the CRS and saving the package in the repository, see “Saving a 
Script Template or Scenario Package in the CRS” on page 43. If the CRS is 
not enabled, you are prompted to save the scenario package in your regular 
directory structure.
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When you click the View Sessions button, The Sessions page opens, 
displaying data for each session in which the selected transaction was run 
and a transaction snapshot was collected, as well as certain key statistic 
averages of all the displayed sessions.

For additional information on the Sessions page, see “Session Analyzer 
Report” in Using End User Management.
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 2 Select the session you want to use for your VuGen script, based on page hit 
and error data, and click the View Session Details button. The Session 
Details page opens, displaying general session and event information, as 
well a list of all the pages accessed as part of the session and the events and 
response time for each page. The pages that were included in the selected 
transaction’s definition are highlighted.

Note: Event data is displayed only if you configured events for the 
application with which the transaction you are viewing is associated. For 
information on events and their configuration, see “Configuring Events” in 
End User Management Data Collector Configuration.

For additional information on the Session Details page, see “Viewing Session 
Details” in Using End User Management.
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Replaying a Session
To replay a session page by page in your Web browser, click Session Replay. 
The Session Flow window opens, displaying two panes.

In the left pane, a list of all the pages in the session is displayed, as well as an 
entry for the session properties. In the right pane are two tabs. If you click 
Session properties in the left pane list, the Properties tab displays general 
session properties and the General Events tab displays the name and 
description of configured events that occurred in the session. If you click a 
page in the left pane list, the Snapshot View tab displays the snapshot of the 
page, if it exists, and the Details tab displays general page details and 
configured events that occurred on the page. To view the HTML source code 
of a snapshot, click the View Source button at the bottom of the snapshot. A 
new window opens displaying the source code.
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To navigate through the pages of the session, click the Previous and Next 
arrows in the top left corner. To save the session as an HTML file, click the 
Save button. If you have enabled the CRS, the session is saved in the 
repository. Otherwise, the session is saved to the directory you specify 
within your file system.

Generating a Script Template
From the Session Details page, you click Generate Script Template to 
generate a template for your VuGen script that includes the pages in the 
current session. If you have enabled the CRS on the Infrastructure Settings 
Manager page, you are prompted to save the script template in the 
repository. For details on enabling the CRS and saving scripts in the 
repository, see “Saving a Script Template or Scenario Package in the CRS” on 
page 43. If the CRS is not enabled, you are prompted to save the script 
template in your regular directory structure.

Note that you should generate a script template for each transaction you 
would like to include in your Performance Center load test.

Tip: Save all your script templates in the same directory so that they are all 
easily accessible when constructing a Performance Center load test.

Typical Transaction Load Report

The Typical Transaction Load report shows the average transaction load (the 
number of Real User Monitor transaction runs) during a typical hour, day, or 
week within a larger time frame that you select. You use the data in this 
report to view the typical load on your system during specific time frames, 
which can assist you in determining the time frame you want to use for your 
Performance Center load test.

In addition, you can use the data in this report, together with the data in the 
Business Process Distribution report, to assist you in selecting the 
transactions to include in your VuGen script templates.
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This section includes the following topics:

➤ “Generating the Typical Transaction Load Report” on page 16

➤ “Analyzing the Typical Transaction Load Report” on page 19

Generating the Typical Transaction Load Report
From the View a typical list, select Hour, Day, or Week. Then select the time 
range during which you want to view a typical hour, day, or week, the way 
you would select the time range for any other Mercury Business Availability 
Center report. For details, see “Working in Reports” in Working with 
Applications. Note that if you already selected a time range in the other 
Business Process Distribution report, the time range you previously selected 
will automatically be displayed in the Typical Transaction Load report.

By default, the Typical Transaction Load report displays data for the 
transactions you previously selected in the Business Process Distribution 
report. If the Typical Transaction Load report is the first Production Analysis 
report you are accessing, or if you want to display data for a different group 
of transactions, click the Transaction Selection link. In the Select 
Transactions dialog box, choose All applications to display the transactions 
from all monitored applications, or choose a specific application to display 
only transactions that were defined for that application. Select the 
transaction(s) for which you want to view data, and click the first arrow. To 
view data for all the transactions listed, click the second arrow. Click OK to 
close the dialog box and save your settings.
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When you click the Generate button, the Typical Transaction Load report 
displays the following:

➤ In the View as Graph tab: a graph showing the average number of 
transaction runs for the selected transactions during a typical hour, day, or 
week within the time frame you specified.

Note that the transaction runs for each sub-unit are an average of the 
transaction runs for all the occurrences of the sub-unit during the specified 
time frame. For example, in the above graph, the transaction runs listed for 
the APL_SearchTx transaction on Tuesday are an average of all the 
APL_SearchTx transaction runs on Tuesdays over the course of the specified 
month.

➤ In the View as Table tab: a table showing the average number of transaction 
runs per sub-unit (day, hour, or minute) for each selected transaction, as 
well as an average of each sub-unit for all selected transactions, an average 
of all sub-units for each transaction, and an average of all the sub-units for 
all the transactions.
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To exclude certain days of the week from the calculation of a typical day or 
hour, click the Working Days link. In the Working Days dialog box, clear the 
days of the week you want to exclude from the Typical Transaction Load 
report’s calculation of a typical day or hour, and click OK.

To exclude certain hours of the day from the calculation of a typical hour, 
click the Working Hours link. In the Working Hours dialog box, select a 
range other than 12:00 AM to 11:00 PM, and click OK. The Typical 
Transaction Load report includes only the hours you selected in its 
calculation of a typical hour.

Note: You can print the report, produce a printer-friendly version of the 
report in .pdf format, format the report in .csv or .xml format, send the 
report by e-mail, publish the report with updated data, or save the report to 
the report repository using the toolbar at the top right-hand corner of the 
report. For details, see “Sharing and Storing Reports” in Working with 
Applications.

If the Central Repository Service (CRS) is enabled, you can export a PDF of 
the report to the CRS by selecting Export > Central Repository Service. For 
details on exporting the report to the CRS, see “Exporting a Report to the 
CRS” on page 42.
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Analyzing the Typical Transaction Load Report
You use the Typical Transaction Load report to view the average transaction 
load during a typical week, day, or hour. In general, you use the Typical 
Transaction Load report, and the ability to drill down within this report, to 
pinpoint the time frame you want to use for your Performance Center load 
test. For example, if you selected to view a typical week during the past 
month, the Typical Transaction Load report may display data such as the 
following.
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Since Wednesday is typically the day with the greatest number of 
transaction runs, you would choose to run your load test on a Wednesday. 
To view the specific hours on Wednesday at which transaction load was 
typically at its peak, click one of the bars in the Wednesday column. The 
Typical Transaction Load graph displays the typical load for each hour on 
Wednesday.

Since load is typically greatest at 9:00 AM or 11:00 AM, you would choose to 
run your load test during this time range. Note that you can also drill down 
to view the minutes during which transaction load was typically at its peak, 
however this data is less relevant for the construction of a load test than the 
typical daily and hourly data.

Note: You can also use this report in conjunction with the Business Process 
Distribution report to determine whether a large number of runs displayed 
for a transaction in the Business Process Distribution report is typical of the 
transaction’s behavior during the selected time period. If the Typical 
Transaction Load report indicates that the transaction load displayed in the 
Business Process Distribution report is typical of the transaction’s load 
during the selected time period, it is recommended that you use the 
transaction for your VuGen script.
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Location Load Analysis Report

The Location Load Analysis report shows the transaction load (the number 
of Real User Monitor transaction runs) and bit rate (bits per second) per end-
user location. You use the data in this report in configuring Vusers and load 
generators for your Performance Center load test, as well as the run-time 
settings for your Application Performance Lifecycle-generated VuGen script.

This section includes the following topics:

➤ “Generating the Location Load Analysis Report” on page 21

➤ “Analyzing the Location Load Analysis Report” on page 23

Generating the Location Load Analysis Report
You select the time range for the Location Load Analysis report as you would 
for any other Mercury Business Availability Center report. For details, see 
“Working in Reports” in Working with Applications. Note that if you already 
selected a time range in one of the other Production Analysis reports, the 
time range you previously selected will automatically be displayed in the 
Location Load Analysis report.

If you already selected transactions in one of the other Production Analysis 
reports, by default the Location Load Analysis report displays data for the 
previously selected transactions. If the Location Load Analysis report is the 
first Production Analysis report you are accessing, or if you want to display 
data for a different group of transactions, click the Transaction Selection 
link. In the Select Transactions dialog box, choose All applications to display 
the transactions from all monitored applications, or choose a specific 
application to display only transactions that were defined for that 
application. Select the transaction(s) for which you want to view data, and 
click the first arrow. To view data for all the transactions listed, click the 
second arrow. Click OK to close the dialog box and save your settings.
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To select locations to be displayed in the Location Load Analysis report, click 
the Location Selection link. By default, the Select Locations dialog box 
displays the locations associated with the transactions you selected. Select 
the location(s) for which you want to view data, and click the first arrow. To 
view data for all the locations listed, click the second arrow. To view data for 
locations that have not been assigned names, select the Use unknown 
locations check box. Click OK to close the dialog box and save your settings.

When you click the Generate button, the Location Load Analysis report 
displays the following:

➤ In the View as Graph tab: the Transaction Runs per Location graph, showing 
the total number of transaction runs for each location at which the selected 
transactions were run, and the Transaction Bit Rate per Location graph, 
showing the transaction bit rate (bits per second) for each location at which 
the selected transactions were run.
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➤ In the View as Table tab: a table listing the bit rate (bits/second) and total 
number of runs for each transaction at each location, as well as an average 
of the bit rates and total runs of all the transactions at a location, an average 
of the bit rates and total runs for each transaction across all locations, and 
an overall average bit rate and total run calculation for all transactions 
across all locations.

Note: You can print the report, produce a printer-friendly version of the 
report in .pdf format, format the report in .csv or .xml format, send the 
report by e-mail, publish the report with updated data, or save the report to 
the report repository using the toolbar at the top right-hand corner of the 
report. For details, see “Sharing and Storing Reports” in Working with 
Applications.

If the Central Repository Service (CRS) is enabled, you can export a PDF of 
the report to the CRS by selecting Export > Central Repository Service. For 
details on exporting the report to the CRS, see “Exporting a Report to the 
CRS” on page 42.

Analyzing the Location Load Analysis Report
You use the Location Load Analysis report to view the distribution of Real 
User Monitor transaction runs among end-user locations, as well as the bit 
rate of each transaction at each location. You then use the location data in 
selecting load generators, the transaction run data in distributing Vusers 
among load generators, and the bit rate data in configuring each script’s 
network speed simulation settings.
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For example, if you selected to view location data for four transactions—
APL_BuyTx, APL_MyAccountTx, APL_SearchTx, and APL_MyOrdersTx—
during the past month, the Location Load Analysis report may display data 
such as the following.

Based on this report, you may choose to select load generators from one or 
more of the above locations when configuring your load test. Your 
distribution of Vusers among the load generators would most likely be based 
on the distribution of transaction load (that is, the number of transaction 
runs being run) among the above locations. For an explanation of 
configuring load tests based on Production Analysis report data, see 
Chapter 4, “Configuring and Running a Load Test.”

In addition, you would use the bit rate data in this report in configuring the 
Network: Speed Simulation VuGen run-time settings of the Application 
Performance Lifecycle-generated scripts that you are using for your load test. 
For example, if you generated a script based on the APL_SearchTx 
transaction and planned to run this script from two load generators—one 
located in Los Angeles and the other in San Francisco—you would do the 
following:

➤ create two copies of the script;

➤ set the custom bandwidth for the script being run from Los Angeles at 
182,127,139 bits per second;

➤ set the custom bandwidth for the script being run from San Francisco at 
231,718,670 bits per second.

For details on configuring Application Performance Lifecycle-generated 
scripts based on data from the Location Load Analysis report, see “Setting 
the Speed Simulation” on page 32.



Chapter 2 • Working with Application Performance Lifecycle Reports

25

Using Application Performance Lifecycle Reports – A Case 
Scenario

This section describes a typical case scenario in which a user worked with all 
three Application Performance Lifecycle reports to obtain the information 
he required to construct a Performance Center load test. 

Initially, the user accessed the Business Process Distribution report to view 
data for the five transactions with the greatest number of run instances 
during the period of a week, from January 26, 2006 to February 2, 2006. The 
Business Process Distribution report showed that APL_SearchTx was the 
transaction with the greatest number of runs—a total of 4,114 transaction 
runs—as well the most popular transaction (run in 18% of the sessions).

To verify that this data reflected the typical transaction load for the 
APL_SearchTx transaction during this time period, the user accessed the 
Typical Transaction Load report and viewed data for a typical week during 
the monthly period of January 2, 2006 to February 2, 2006. The Typical 
Transaction Load report showed that the average transaction load for the 
APL_SearchTx transaction was indeed significant during this period of time.

The user then drilled down further in the Typical Transaction Load report to 
discover the specific hours on Wednesday (the day with the greatest number 
of transaction runs) during which transaction load was typically at its peak. 

The drilldown showed that load was typically greatest at 9:00 AM, so the 
user decided that he would later run his load test at this hour. To be able to 
use this data as well as the average transaction run data later on, when 
configuring a load test, the user saved the report in .PDF format.
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Having received confirmation of the significance of the APL_SearchTx 
transaction, the user returned to the Business Process Distribution report to 
generate a VuGen script of a session in which the APL_SearchTx transaction 
was run. To view the sessions in which APL_SearchTx was run and a 
transaction snapshot was collected, the user clicked the View Sessions 
button. After viewing error and page hit data for each displayed session, the 
user selected to view details of a session with 1 application error, 1 HTTP 
error, and 13 page hits.

The user then clicked the View Session Details button to view details of the 
end user that ran the selected session, as well as the pages that were accessed 
as part of the session (with those included in the transaction highlighted).

After viewing all of this data, the Application Performance Lifecycle user 
decided to use this session as the basis for a VuGen script and clicked 
Generate Script Template on the Session Details page to Application 
Performance Lifecycle to create a script template from the session. The user 
saved the generated script to the CRS.
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To prepare additional data for the configuration of his load test, the user 
accessed the Location Load Analysis report and selected to view location 
data for the APL_SearchTx transaction. The Location Load Analysis report 
showed that end users at three locations—Los Angeles, San Diego, and San 
Francisco—ran the APL_SearchTx transaction.

To be able to use this data for his Performance Center load test, the user 
saved the Location Load Analysis report in .PDF format.

Based on this report, the user decided to run the script he generated from 
three different load generators, each located at one of the above locations. 
To do so, the user created three different copies of the script and set the 
Network: Speed Simulation VuGen run-time settings for each script 
according to the bit rate for the location from which the script was going to 
be run (for details, see “Setting the Speed Simulation” on page 32). The user 
also based his distribution of Vusers among the load generators on the 
distribution of total runs among the above locations. (For details on 
configuring load tests, see Chapter 4, “Configuring and Running a Load 
Test.”)

Note: The above case scenario describes the generation of one script, based 
on one transaction, however a true use case will typically include several 
scripts, based on several different transactions. 
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3
Refining Your Script Template in VuGen

To use Application Performance Lifecycle-generated scripts in a Performance 
Center load test, you must first customize them using VuGen.

Note: If you exported the script templates you created in Application 
Performance Lifecycle to the CRS, see “Opening a Script Saved in the CRS” 
on page 44 for details on how to open the script templates in VuGen.

This chapter describes: On page:

Parameterizing Recorded Values 30

Correlating Recorded Values 32

Setting the Speed Simulation 32
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Parameterizing Recorded Values

When you generate a script using Application Performance Lifecycle, the 
script contains the actual end-user values that the Real User Monitor 
recorded. If you want to perform the script’s actions (query, submit, and so 
forth) using different values from those recorded by the Real User Monitor, 
you must replace the values with parameters.

For example, suppose you generated a script containing the following 
statement that searches a library’s database for the title UNIX: 

 web_submit_form("db2net.exe",
ITEMDATA,
"name=library.TITLE",
"value=UNIX",
ENDITEM,
"name=library.AUTHOR",
"value=",
ENDITEM,
"name=library.SUBJECT",
"value=",
ENDITEM,
LAST);

;
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When you run this script in a Performance Center load test, you do not 
want to repeatedly use the same value, UNIX. You therefore replace the 
constant value with a parameter:

When you run a load test using a parameterized script, Vusers substitute the 
parameter with different values from a data source that you specify. The data 
source can be either a file or internally generated variables.

For detailed instructions on replacing the constant values in your generated 
script with parameters, as well as setting the properties and data source for 
these parameters, see “Working with VuGen Parameters” in Using Mercury 
Virtual User Generator.

Notes:

➤ You can parameterize complete strings or parts of strings.

➤ You can define more than one parameter for functions with multiple 
arguments (such as URLs, server names, and IP addresses).

web_submit_form("db2net.exe",
ITEMDATA,
"name=library.TITLE",
"value={Book_Title}",
ENDITEM,
"name=library.AUTHOR",
"value=",
ENDITEM,
"name=library.SUBJECT",
"value=",
ENDITEM,
LAST);
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Correlating Recorded Values

In addition to parameterizing the script you generated using Application 
Performance Lifecycle, you must correlate certain statements within the 
script. Correlation allows you to link statements by using the results of one 
statement as input for another.

You correlate statements for one or both of the following reasons:

➤ to generate dynamic data – For example, if the Real User Monitor session 
from which you generated your script was identified by the date and time, 
when you try to replay a script of this session, it will fail because the current 
time is different than the original recorded time. Only if you correlate the 
date and time will you be able to save it as dynamic data and use it 
throughout the load test or session step run.

➤ to accommodate unique data records – For example, if the Real User 
Monitor recorded a session requiring the use of unique values, such as the 
process of opening a new bank account, replaying a script of the session will 
fail because the recorded value already exists and cannot be recreated. 
Correlating the value enables you to create additional unique values—based 
on the recorded value—to be used throughout the load test or session step 
run.

For detailed instructions on correlating a script, see “Correlating 
Statements” in Using Mercury Virtual User Generator.

Setting the Speed Simulation

You set the speed simulation for your Application Performance Lifecycle-
generated script based on data contained in the Location Load Analysis 
report.

To set the speed simulation for a script:

 1 In VuGen, select Vuser > Run-Time Settings or click the Run-Time Settings 
button on the toolbar to open the Run-Time Settings dialog box.
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 2 In the Run-Time Settings tree, select the Network: Speed Simulation node.

 3 Select Use custom bandwidth and specify the bit rate of the location from 
which you want to run the script, according to the bit rate displayed for this 
location (for the transaction upon which the script is based) in the Location 
Load Analysis report. For example, if the transaction upon which your script 
is based was run by a significant number of users in Los Angeles, California, 
you would specify the bit rate displayed for Los Angeles in the Location 
Load Analysis report’s Transaction Bit Rate Per Location graph.

Note: If you want to run the same script from several different locations, 
you can save several copies of the script and assign each copy a custom 
bandwidth reflecting the bit rate of a specific location. For details on 
assigning load generators to each copy of the script, see Chapter 4, 
“Configuring and Running a Load Test.”

 4 Click OK to apply the updated run-time settings.
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4
Configuring and Running a Load Test

This chapter describes how to configure and run Performance Center and 
LoadRunner load tests that incorporate the scripts you created using 
Application Performance Lifecycle and emulate the real-user behavior 
displayed in the Production Analysis reports.

Configuring and Running a Load Test in Performance 
Center

After you have refined your Application Performance Lifecycle-generated 
scripts using VuGen, you can create a load test in Performance Center that 
incorporates these scripts and emulates the real-user behavior displayed in 
the Production Analysis reports.

This section describes how to incorporate the Application Performance 
Lifecycle-generated scripts and Production Analysis report data in designing 
a load test. For detailed instructions on creating a load test, refer to the 
Mercury Performance Center User’s Guide. 

This chapter describes: On page:

Configuring and Running a Load Test in Performance Center 35

Configuring and Running a Scenario in LoadRunner 37
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To incorporate Application Performance Lifecycle-generated scripts in a 
load test:

Connect VuGen to the Performance Center Web server and either upload 
your script files directly to the Performance Center Web server or save them 
in the file system. For detailed instructions, see “Uploading Vuser Scripts” in 
Using Mercury Virtual User Generator.

If you saved the Application Performance Lifecycle-generated scripts in the 
CRS, see “Uploading Scripts from the CRS to Performance Center” on 
page 45 for details on uploading the scripts to the Performance Center Web 
server.

To incorporate the Production Analysis report data in a load test:

 1 Access the Business Process Distribution, Typical Transaction Load, and 
Location Load Analysis reports that you printed, e-mailed, or saved while 
working with the Production Analysis reports. For details on retrieving a 
report from the CRS, see “Retrieving a Report Saved in the CRS” on page 45.

 2 In Performance Center, select Load Tests > Create/Edit from the left menu 
to open the Load Tests page.

 3 Click New Load Test to create a new load test. 

 4 In the Design Groups tab, select the scripts you generated using Application 
Performance Lifecycle and customized in VuGen. Select one or more load 
generators to run each script, based on the location data in the Location 
Load Analysis report. For example, if the transaction upon which one of 
your scripts is based was run from Los Angeles, California, you would select 
one or more load generators located in Los Angeles to run this particular 
script.

Note: Ensure that the Network: Speed Simulation run-time settings of each 
script are set to match the bit rate specified in the Location Load Analysis 
report for the location from which the script is being run. For details on 
configuring Network: Speed Simulation run-time settings, see “Setting the 
Speed Simulation” on page 32.
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Distribute the Vusers among the Vuser groups based on the distribution of 
transaction load among the locations displayed in the Location Load 
Analysis report, represented by the load generators you selected for each 
group. For example, if the transactions upon which your scripts are based 
were run from three locations and each location ran approximately one 
third of the transactions, you would distribute the Vusers evenly among the 
Vuser groups.

The overall number of Vusers for your load test should be based on the 
average transaction run data in the Typical Transaction Load report. In 
specifying the number of Vusers to run, however, ensure that you take into 
account the difference in scaling between load test and production 
environments.

 5 In the Scheduler tab, configure the Ramp Up and Ramp Down of Vusers 
based on data in the Typical Transaction Load report. For example, if the 
Typical Transaction Load report showed that an average of 100 transactions 
were run at the beginning of the time period you selected to use for your 
load test and 80 transactions were run at the end of this time period, you 
might configure your load test to start 100 Vusers every hour and stop 80 
Vusers every hour. Note, however, that you must take into account the 
difference in scaling between load test and production environments.

 6 Complete your load test configuration and run the load test from the Load 
Tests Configuration page by clicking Start, or from the Load Tests page by 
clicking the Run Test icon in the row of the load test that you want to run. 
For details on configuring and running a load test, refer to the Mercury 
Performance Center User’s Guide.

Configuring and Running a Scenario in LoadRunner

After you have refined your Application Performance Lifecycle-generated 
scripts using VuGen, you can create a manual scenario in the LoadRunner 
Controller that incorporates these scripts and emulates the real-user 
behavior displayed in the Production Analysis reports.

This section describes how to incorporate the Application Performance 
Lifecycle-generated scripts and Production Analysis report data in designing 
a manual scenario. For detailed instructions on creating a manual scenario, 
refer to the Mercury LoadRunner Controller User’s Guide. 
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To incorporate Application Performance Lifecycle-generated scripts in a 
scenario:

 1 In the New Scenario dialog box, choose Manual Scenario. Do not select the 
Use the Percentage Mode check box.

 2 Click the Browse button, navigate to the directory in which you saved the 
Application Performance Lifecycle-generated scripts that you modified using 
VuGen, and select the scripts.

If these scripts are saved in the CRS, see “Opening a Script Saved in the CRS” 
on page 44 for details on selecting them.

 3 Click the Add button to add the scripts to your scenario.

To incorporate the Production Analysis report data in a scenario:

 1 Access the Business Process Distribution, Typical Transaction Load, and 
Location Load Analysis reports that you printed, e-mailed, or saved while 
working with the Production Analysis reports. For details on retrieving a 
report from the CRS, see “Retrieving a Report Saved in the CRS” on page 45.

 2 In LoadRunner, to the right of the Scenario Groups pane, click the Add 
Group button. Select a script you generated using Application Performance 
Lifecycle and customized in VuGen. Select one or more load generators to 
run the script, based on the Location Load Analysis report’s location data for 
the transaction upon which the script is based. For example, if the 
transaction upon which one a script is based was run from Los Angeles, 
California, you would select one or more load generators located in Los 
Angeles to run this script.

Note: Ensure that the Network: Speed Simulation run-time settings of the 
script are set to match the bit rate specified in the Location Load Analysis 
report for the location from which the script is being run. For details on 
configuring Network: Speed Simulation run-time settings, see “Setting the 
Speed Simulation” on page 32.



Chapter 4 • Configuring and Running a Load Test

39

Select a quantity of Vusers for the group. Note that Vusers should be 
distributed among Vuser groups based on the distribution of transaction 
load among the locations displayed in the Location Load Analysis report, 
represented by the load generators you selected for each group. For example, 
if the transactions upon which your scripts are based were run from three 
locations and each location ran approximately one third of the transactions, 
you would distribute the Vusers evenly among the Vuser groups.

The overall number of Vusers for your scenario should be based on the 
average transaction run data in the Typical Transaction Load report. In 
specifying the number of Vusers, however, ensure that you take into 
account the difference in scaling between load test and production 
environments.

Note: You use the Add Group dialog box to add each Application 
Performance Lifecycle-generated script you want to include in your 
scenario. Since each location requires specific script network run-time 
settings, each location requires its own unique script. For details on 
preparing a script to be run from each location, see “Setting the Speed 
Simulation” on page 32.

 3 In the Schedule Builder, configure the Ramp Up and Ramp Down of Vusers 
based on data in the Typical Transaction Load report. For example, if the 
Typical Transaction Load report showed that an average of 100 transactions 
were run at the beginning of the time period you selected to use for your 
load test and 80 transactions were run at the end of this time period, you 
might configure your load test to start 100 Vusers every hour and stop 80 
Vusers every hour. Note, however, that you must take into account the 
difference in scaling between load test and production environments.

 4 Complete your scenario configuration and run the scenario from the Run 
tab of the Controller. For details on configuring and running a scenario, 
refer to the Mercury LoadRunner Controller User’s Guide.
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5
Working with the Central Repository 
Service (CRS)

This chapter describes how to export Production Analysis reports to the CRS, 
generate a script template or scenario package and save it in the CRS, open 
scripts saved in the CRS, retrieve reports saved in the CRS, and upload 
scripts saved in the CRS to Performance Center.

This chapter describes: On page:

Exporting a Report to the CRS 42

Saving a Script Template or Scenario Package in the CRS 43

Opening a Script Saved in the CRS 44

Retrieving a Report Saved in the CRS 45

Uploading Scripts from the CRS to Performance Center 45
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Exporting a Report to the CRS

By default, the CRS is enabled on the Infrastructure Settings Manager page 
and you can export the Production Analysis reports to the CRS.

Note: If the CRS was disabled, you can re-enable it by accessing the 
Infrastructure Settings Manager page (Admin > Platform > Setup and 
Maintenance > Infrastructure Settings), clicking Foundations, selecting 
Production Analysis, locating the CRS Enabled entry in the Production 
Analysis – Central Repository Service table, and setting the property value to 
true.

To export a report to the CRS:

 1 From the toolbar at the top right-hand corner of the report, select Export > 
Central Repository Service. A new browser window opens, displaying Report 
under Type.

 2 In the Name text box, enter the name under which you want to save the 
report in the repository.

 3 In the Description text box, enter a description of the report. Note that this 
field is optional.

 4 Browse the Root directory tree to select the folder in which you want to save 
the report. The files that are currently stored in the selected folder are 
displayed in the Folder Content table on the right.

To save the report in a new folder, click the Create New Folder button, enter 
the folder name and description, click OK, and then click the Refresh button 
to view the new folder in the directory tree.

To rename a folder, click the Rename Folder button, enter the new folder 
name, click OK, and then click the Refresh button to view the new folder 
name in the directory tree. To delete a folder, click the Delete Folder button 
and click Yes.
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 5 Click Save. If the save process has been completed successfully, Report saved 
to repository is displayed at the top of the browser window.

 6 Click Close to close the browser window and return to the report you were 
viewing.

Saving a Script Template or Scenario Package in the CRS

By default, the CRS is enabled on the Infrastructure Settings Manager page 
and you can save your generated script templates or a scenario package in 
the CRS.

Note: If the CRS was disabled, you can re-enable it by accessing the 
Infrastructure Settings Manager page (Admin > Platform > Setup and 
Maintenance > Infrastructure Settings), clicking Foundations, selecting 
Production Analysis, locating the CRS Enabled entry in the Production 
Analysis – Central Repository Service table, and setting the property value to 
true.

To save a scenario package or script template in the CRS:

 1 Click the Generate Scenario Package button in the Business Process 
Distribution report, or the Generate Script Template button at the top of 
the Session details page. A new browser window opens, displaying Scenario 
Package or VuGen Script under Type.

 2 In the Name text box, enter the name under which you want to save the 
scenario package or script template in the repository.

 3 In the Description text box, enter a description of the scenario package or 
script template. Note that this field is optional.

 4 Browse the Root directory tree to select the folder in which you want to save 
the scenario package or script template. The files that are currently stored in 
the selected folder are displayed in the Folder Content table on the right.
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To save the scenario package or script template in a new folder, click the 
Create New Folder button, enter the folder name and description, click OK, 
and then click the Refresh button to view the new folder in the directory 
tree.

To rename a folder, click the Rename Folder button, enter the new folder 
name, click OK, and then click the Refresh button to view the new folder 
name in the directory tree. To delete a folder, click the Delete Folder button 
and click Yes.

 5 Click Generate. If the generation process has been completed successfully, 
Scenario package saved to repository or VuGen script template saved to 
repository is displayed at the top of the browser window.

 6 Click Close to close the browser window and return to main page or Session 
Details page of the Business Process Distribution report.

Opening a Script Saved in the CRS

You can open scripts saved in the CRS from both VuGen and the 
LoadRunner Controller.

To open a script saved in the CRS:

 1 In the main VuGen window, select Tools > Quality Center Connection. In 
the LoadRunner Controller’s New Scenario dialog box, click the Quality 
Center button.

 2 In the Quality Center Connection dialog box, enter the CRS URL, 
http://<Mercury Business Availability Center server machine>:8080/qcbin, 
and click Connect. 

 3 Click Browse in the Controller, or select File > Open in VuGen, to select the 
scripts you saved in the CRS. If the scripts were automatically generated by 
Application Performance Lifecycle, they are located in a zip file within the 
scenario package file you created.

Note: When you save your scripts after editing them in VuGen, they are 
automatically saved in the CRS.
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Retrieving a Report Saved in the CRS

You can retrieve a report saved in the CRS in order to incorporate its data in 
your Performance Center load test or LoadRunner scenario.

To retrieve a report saved in the CRS:

 1 Access the CRS URL (http://<Mercury Business Availability Center server 
machine>:8080/qcbin).

 2 Download the report PDF saved in the CRS by clicking the Download 
button. If the report is a Summary report that is part of a scenario package, it 
can be downloaded from the scenario package zip file.

Uploading Scripts from the CRS to Performance Center

To incorporate scripts saved in the CRS in your Performance Center load 
test, you must upload the scripts to the Performance Center Web server.

To upload scripts from the CRS to Performance Center:

 1 In the main VuGen window, select Tools > Quality Center Connection and 
open the scripts you saved in the CRS as described in “Opening a Script 
Saved in the CRS” on page 44.

 2 Connect VuGen to the Performance Center Web server as described in 
“Connecting VuGen to Performance Center” in Using Mercury Virtual User 
Generator.

 3 Upload the script files to the Performance Center Web server as described in 
“Uploading Vuser Scripts” in Using Mercury Virtual User Generator.
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